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FORMATTING FOR ABSTRACTS AND PAPERS 
 

MARGINS, FONTS, AND PAGE NUMBERING 

● Margins should be set to one (1) inch; the main body of the paper should be justified right and left. 

● The preferred font for AZVT is Times New Roman, 12 pt. 

● Do not sequentially number the pages or place the author's name on top of every page. This makes 

compilation of all papers difficult. 

● See Sample Paper Format below. 

 

TITLE 

The paper title appears in BOLD CAPITAL LETTERS at the top of the first page only. 

● Paper title should be left justified; it is not centered. 

● Scientific names of animals should be included, if appropriate, but should not be capitalized, except for 

the first letter of the Genus name. Genus and species should be bold italicized. 

● See Sample Paper Format below. 

 

AUTHORS 

Author names are included beneath the abstract or paper title. Include the full name(s) and academic degree(s) 

and/or certification(s) / registration(s) / license(s) information of all authors. A semicolon (;) is used between 

authors. 

Following each author's name, the name of the institution(s) with which they are affiliated and the address(es) for 

the institution(s) are provided. 

● The address(es) provided should be from the institution(s) where the author(s) was/were working when 

the research/case/study happened or was conducted. 

o If an author has moved to another institution, new contact information may be provided as a note 

under the author information, if desired. This should be clearly noted in the submission. 

● Author names and institutions are left justified. 

● Phone numbers are not required. 

● See Sample Paper Format below. 

 

HEADINGS 

Headings will be included as appropriate and may include: Abstract, Introduction, Materials and Methods, Case 

History, Results, Discussion, and/or Conclusion. 

Headings are written in CAPITAL LETTERS and left justified. 

See Sample Paper Format below. 
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FIGURES 

Figures can include images, photographs, drawings, graphs or charts of information relevant to your topic. All 

figures should have a Figure number (which will be cited within the paper), a title for the figure, and enough of 

a description so that the figure can stand alone, without the benefit of the information within the paper. 

Formatting Figures 

● Number, title, and description are presented underneath the figure. 

● The Figure number is formatted in bold letters with a colon (:) to separate the number from the title. 

● The Figure title is formatted in italics with a period (.) to separate the title from the description. 

● The description should have enough detail and information so that if the figure was presented by itself, 

the person viewing the figure would understand what is being shown just from the description provided. 

● See below for an example: 
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Figure 1: Weight Gain Chart. Chart graphically represents weight gained by the 

animal from Week 1 to Week 29. 

 

PHOTOGRAPHS 

An important note about photographs – You MUST use original images that you took or that are approved by 

your institution for publication. Be sure to provide the name of the photographer, if known, with each photograph. 

● If you wish to use images that have a copyright, you must provide a letter of permission from the copyright 

holder. If this is not provided, the image will not be included in the proceedings. 

● NOTE: The proceedings publication is in black and white, so photographs must be easily converted to 

this format. 
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● High quality drawings may also be accepted. The same copyright concerns apply to these images. 

● Please include a description or caption about your image! See information above regarding Figures. 

 

TABLES 

Tables are presented as rows and columns of information with clearly understandable column headers. All tables 

should include the Table number (which will be cited within the paper), a title for the table, and enough of a 

description so that the table can stand alone, much in the same way as for a figure. 

Formatting Tables 

▪ Number, title, and description are presented above the table. 

▪ The Table number is formatted in bold letters with a colon (:) to separate the number from the title. 

▪ The Table title is formatted in italics with a period (.) to separate the title from the description. 

▪ Room may be left underneath the table for a key or other information that may provide the reader with a 

better understanding of the information within the table. 

▪ The description should have enough detail and information so that if the table was presented by itself, the 

person viewing the table would understand what is being shown just from the description provided. 

▪ See below for an example: 

 

Table 1: Monthly Weights. Weights were taken 

every four weeks to measure weight gain progress 

of the animal. 

 

Date Weight (kg) 

1/7/2013 1.0 

2/4/2013 1.2 

3/4/2013 1.5 

4/1/2013 1.6 

4/29/2013 1.8 

5/27/2013 2.0 

6/24/2013 2.3 

7/22/2013 2.5 

 

IMPORTANT NOTE ABOUT TABLES AND FIGURES 

Please remember that your audience includes many members of AZVT who are not able to attend the conference. 

Information provided in the table or figure descriptions should stand alone. That is, the description captures what 

is being presented in the table or figure without the benefit of the rest of your paper. 
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WORD COUNT AND MAXIMUM PAGE NUMBER 

Abstract 

The maximum word count for abstracts can be up to 300 words. 

IMPORTANT NOTE: If you or your veterinarian are planning on submitting your topic to a journal for 

publication, you MUST keep your abstract word count at or below 250 words. 

Please make sure you inform your Section Chair and the Editor-in-Chief if this is the case. 

Full Paper 

There is currently not a maximum word count or page number for full papers submitted to the AZVT Annual 

Conference Proceedings. Historically, the full papers have ranged from 2 to 5 pages long. In recent years, the 

page count has increased for some full papers. 

Ultimately, the length of the full paper should be justified by the content required by the particular topic. The 

author, Section Chair, and Editor-in-Chief will work together to determine what is most appropriate. 

 

DATES 

When indicating dates (e.g. for case studies), please format the date as Month Day, Year (e.g. May 20, 2011). 

Please do not write “Day 1” or write the date in another order. 

 

REFERENCES TO DRUGS OR PRODUCTS 

All appropriate information, including the manufacturer name and location, will be indicated as a footnote in the 

final publication of the paper or abstract. 

However, you should indicate this information within the text of your document. The Editor-in-Chief will format 

the footnotes as it is difficult to combine several papers with separate footnotes. 

When Referencing Drugs 

(Referencing information modified from the Journal of Zoo and Wildlife Medicine Author Guidelines) 

● You must indicate at least the generic name of the drug; the brand name is optional. 

● The name and location of the manufacturer of the drug must also be included. 

● The dose (by weight) that was given to the animal must also be included. The dose may be listed within 

the document text, or it may be included as part of the reference (see below). 

o For example: “The animal was given enrofloxacin (2.5 mg/kg; Baytril®, Bayer Animal Health, 

Shawnee Mission, Kansas, 66216).” 

● It is very important that the dose by weight is indicated, so that other institutions will have a reference 

point to use your dosing with their own animals! 

● After you have referenced the drug once, you may continue to use the generic name and dose by weight 

throughout the remainder of the paper. If the dose of the drug did not change throughout the animal’s 

treatment, then it is not necessary to continue referencing the dose by weight. 
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When Referencing Products 

This is used when indicating a specific product by name. Common products such as suture, needles (although 

gauge should be indicated where applicable), syringes, gauze, etc. do not need to be referenced unless you used 

a very specific product for a specific reason and no other product can replace it. 

● You must indicate the product name and the name and location of the manufacturer of the product. Be 

sure to include any applicable Trademark (™), Copyright (©), or Registered (®) symbols. 

o For example: "Immediate testing was performed on an i-Stat® portable clinical analyzer (Heska® 

Corporation, Loveland, Colorado, 80538)." 

● After you have referenced the product in full once, you may continue to use the product name (with any 

applicable trademark, copyright, or registered information) throughout the remainder of the paper without 

the manufacturer information. 

● If you are not sure how to include the symbols, you can write them out in parenthesis (Trademark) and 

the Editor-in-Chief will make the necessary adjustments. 

 

IDENTIFICATION OF ANIMALS IN CASE REPORTS 

When identifying animals within a case report, do not use the in-house name of the animal. 

● Keep references to the animal as non-familiar as possible, with terms like “the animal,” “the lion,” “the 

male,” “the neonate,” “it,” etc. 

● If a neonate is being discussed, refer to the neonate’s ‘mother’ and ‘father’ as the ‘dam’ and ‘sire,’ 

respectively. 

 

CAPITALIZATION FOR COMMON ANIMAL NAMES 

When indicating the common animal name, please make sure that any capitalization within the common name is 

appropriate. 

● For example: Writing the common loon would be correct. Writing the Common Loon would be incorrect. 

● Exceptions include common names that include the name of a person or location as part of the animal 

name. For example: a Johnston’s crocodile. 

 

CITATIONS 

Generally, only full paper submissions will have citations to reference articles or books. If you are writing an 

abstract and wish to include citations, please contact the Editor-in-Chief. 

● Within your text, tables, figures, etc., cite a reference by (Author Year). 

● Arrange the list of references in alphabetical order by the first author’s last name. 

● Please refer to the Reference Guide and CSE Style Guide for the appropriate citation and reference format 

for AZVT. 
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FINAL SUBMISSION 

The final version of your abstract or paper will be formatted as a single-spaced document. 

When your abstract or paper is nearly completed, your Section Chair should submit it via email to the Editor-in-

Chief for final review and editing. NOTE: This means there will be an additional round of editing after your 

Section Chair has worked through the abstract or paper with you. Once the draft has been finalized, you will 

receive a copy of the final version for your records. 
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SAMPLE PAPER FORMAT 
(Modified from J. Arnold, 1997) 

 

TITLE IN ALL CAPS AND BOLD EXCEPT FOR (Genus species) 

 

Christina Camillo, EdD, MLS(ASCP)CM 1; Dianna Lydick, LVT, VTS(Zoo)2 

 
1Salisbury University, 1101 Camden Avenue, Salisbury, MD 21801, USA; cgcamillo@gmail.com 
2Dallas Zoo, Veterinary Hospital, 650 South R.L. Thornton Freeway, Dallas, TX 75203, USA; 

dllydickk@gmail.com 

 

ABSTRACT 

 

An abstract is presented as one paragraph. Abstracts should represent a condensed version of your paper and/or 

presentation – to include a brief introduction, methods used, results/findings, and a conclusion. The AZVT 

Submission Form has been designed to help authors by providing the applicable sections/topics that should be 

addressed in an abstract. By filling out/answering each box, and then combining them together into one paragraph, 

a rough draft of the abstract should begin to take shape. 

 

INTRODUCTION 

 

The introduction should capture the background of the topic you are presenting or the reasoning for why you are 

examining a certain case, disease process, methodology, instrument, etc. Paragraphs are left and right justified; 

each paragraph is separated with a double return. 

 

When providing background information, appropriate references are encouraged. References should be noted 

with an author last name and year (Arnold 2018). Multiple references are separated by a semicolon and ordered 

from oldest to newest (Lydick 2014; Arnold 2018). Multiple references published in the same year are ordered 

alphabetically. For more information about reference formatting, see the Reference Guide below. 

 

HEADINGS 

 

Headings should appear in all capitals, at the left margin. A few possible headings include: Introduction, 

Background, Case Study, Materials and Methods, Results, Discussion, Conclusion, References, etc. These are 

suggestions and may not fit your topic. Heading should be appropriate for your topic and help guide your reader 

throughout the paper. 

 

For more information about what should be included in each section of your paper see the Components of a 

Scientific Paper, and How to Write a Good One document below. 

 

Subheadings 

 

If subheadings are used, they should be at the left margin, begin with a capital letter, and be italicized. Subheadings 

may be helpful to organize the presentation of your information. These can be used to define the particular case 
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you are discussing, if you are presenting multiple cases. If you are presenting multiple procedures or test methods, 

subheadings may also be helpful so your reader understands what topic you are presenting. 

 

Should you need further organization/division of information, please contact the Editor-in-Chief to determine the 

best way to organize your material. 

 

CONTENT 

 

Your Section Chair and Assistant Editors will read your paper for clarity, cohesion, content, and grammar. You 

will receive comments regarding the layout of the paper: Does it flow well? Are your thoughts clear and easy to 

follow? Does your paper serve the intended purpose? For example, if you discuss a laboratory method, have you 

included sufficient information or references for your reader such that they would be able to repeat the testing? If 

you are discussing a case study, is your description of the case clear and understandable for your readers? 

 

Please Note – for cases, a discussion about the disease process is also a valuable addition to your presentation. 

Please consider adding information related to the disease process so that all can benefit from learning more about 

the condition. 

 

CONCLUSION 

 

Drafts of abstract or full papers should be submitted to your Section Chair and the Editor-in-Chief as a single-

spaced document. The final version for the proceedings will also be single-spaced, but will be presented in a two-

column format. This formatting will be performed by the Editor-in-Chief. 

 

Please Remember: Your Section Chair, Assistant Editors, and the Editor-in-Chief are striving to work with all 

authors to achieve professional proceedings that will best represent each of the contributors and the AZVT 

organization. The proceedings are, essentially, the ‘journal’ for AZVT. We are deeply appreciative of the time 

and work you put into your abstracts and papers and we thank you for your participation! The Annual Conference 

could not happen without people stepping up to present. 

 

REFERENCES 

 

Please provide a list of references that you have used in alphabetical order by the first author’s last name. For 

specific guidelines on reference formatting, please refer to the Reference Guide provided below. 
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COMPONENTS OF A SCIENTIFIC PAPER, AND HOW TO WRITE A GOOD ONE 
Printed with permission; Sarah L. Poynton, Ph.D., Comparative Medicine, Johns Hopkins University School of Medicine 

 

A scientific paper has a standard, highly organized format, consisting of clearly defined components. 

 

To ensure successful scientific writing, remember and follow the 5 C’s: 

Coherence sticking together, logical presentation of parts 

Clarity  being clear 

Consistency agreement, compatibility, parallel structure 

Conciseness expressing much in few words 

Conviction ability to convince, being believable, persuasive  

 

You could also add  

Creativity keeps the reader interested, surprises them 

 

In general, scientific papers are written in the past tense. 

 

Components of a scientific paper 

Title information 

*Title, list of authors, authors’ addresses, and authors’ email contact information 

Abstract 

Introduction 

Materials and Methods 

Results (text, tables, figures, and legends) 

Acknowledgements 

References 

 

TITLE 

Probably more people read this than any other part 

● Gain specificity with a subtitle 

● Consider spelling out your message (i.e. “The Smallest Gene”) 

● Try a sentence title or ask a question 

● Should precisely sum up the contents, be specific and informative 

● Use fewest words possible 

● If applicable, use scientific name plus classification or common name 

 

LIST OF AUTHORS 

● Everybody who has substantially contributed to the work may be an author 

● The first author is the most important person – has done the most research and written the draft 

● An author should be able to explain and defend the contents of the paper in a scientific discussion 
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AUTHORS’ ADDRESSES 

● Give address of institution where the work was done 

● If your present address is different, add it as a footnote 

 

ABSTRACT 

What’s the paper all about? 

● State concisely 

● Problem being studied 

● Method used 

● Principle results 

● Main conclusions 

● Single paragraph 

● No abbreviations, detailed data, speculation, or citations 

● Limit of words (200-250 words) – AZVT max is 300 words. 

 

INTRODUCTION 

What did you do and why? 

● General area, specific problem studied (and why it is of interest) 

● Findings of other people to be challenged or developed (i.e. review of literature) 

● Experimental approach and rationale 

● Principle findings and conclusions (optional, and keep it brief) 

● First time a species is mentioned, give common name and scientific name, subsequently use either 

common name or G. species (and use consistently throughout the paper) 

 

MATERIALS AND METHODS 

How did you do it? 

● If using published methods – identify procedure, give reference 

● If using a modification of published methods – give reference, and details of modification 

● If using a new method – give full details 

● Enough detail for someone else to be able to repeat the work 

● Include statistical analysis (for relevant data, name of statistical test used and confidence level) 

● Omit trivial details such as brand of film, etc. 

● For reagent use, the particular manufacturer may be important 

● Use sub-headings if possible 
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RESULTS (INCLUDING TABLES AND GRAPHS) 

What did you find? 

Scientifically the most important part of the paper 

● Present results here, preferably, no raw data 

● Explain results in discussion section 

● May have subheadings 

● Indicate mean and variability 

● Written description – be sure to refer to all tables and figures, summarize them in the text (main trends) 

● Tables – for precise numerical data 

o Make column headings clear, include units of measure 

o Experiment to find best layout 

● Figures – where trends are more important than principle data 

o If an illustration is essential 

o May be seen by people who don’t bother to read the text 

o Can be arranged in a plate (a coherent group) 

o Ensure photos are of the highest quality 

o Label using commercially available symbols 

● Table titles and figure legends should be precise, informative, and self-explanatory 

 

DISCUSSION 

What does it mean? 

● Present the principles and relationships indicated by the data (level of reliability) 

● Point out exceptions, unresolved details 

● Compare and contrast your findings with those of others 

● State conclusions, implications of data 

● Be sure conclusions follow logically from data 

● Try to have parallel structure with results  

● Clearly identify speculations and hypotheses, argue your findings, give unexpected results 

 

ACKNOWLEDGEMENTS 

● People who provided specimens 

● Technical support 

● Financial support 

● Colleagues who reviewed your paper 
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REFERENCES 

● List only those in print (i.e. published) or in press (i.e. accepted for publication) 

● Remember – YOU are responsible for accuracy 

● Verify contents of references and details of citations 

● Don’t cite if you haven’t read it!!!!!!!! 

● Assemble reference list (complete citations) early 

● If you wish to cite something that is not published or in press, this is a personal communication, and 

appears in the text as……. (Beverly Williams, personal communication, Date) 

● See Reference Guide for more information! 
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NUMBERS AND STATISTICS 
This information comes from Chapter 12 in the Council of Science Editors Manual, 8th Edition (2014) p.157-191. 

This list is not exhaustive. If you have specific questions, please contact the Editor-in-Chief. 

 

MODERN SCIENTIFIC NUMBER STYLE & UNITS AND SYMBOLS WITH NUMBERS AND 

RANGES 
(CSE Style Manual; 12.1.2; p. 158-161 and 12.1.4; p. 163-165) 

Use numerals/numbers and not words to indicate whole and decimal numbers. 

● Note: Numbers beginning a sentence must be spelled. It is better to rewrite a sentence so you do not start it 

with a number. 

o Note: If a number is used at the beginning of a sentence and includes a unit, the unit must be spelled 

out. 

▪ For example: Five milliliters of sample… 

● Note: If two numbers are adjacent, spell out one number and leave the other as a numeral. The best option 

is to keep a measurement as the numeral. A better option would be to reword in order to separate the 

numbers. 

o For example: The sample was divided into eight 50-g aliquots. 

o Better: The sample was divided into 8 aliquots of 50 g each. 

● Note: General uses of zero and one – these should be spelled out 

o For example: values approaching zero; zero-based budgeting; the zeros were… 

o For example: one of the subspecies; at one time; on the one hand 

o Note: If zero or one is associated with a unit of measure they should be numerical. 

▪ For example: 1 year; 1 mm; when z = 0 

Put a space between numbers and units. 

● For example: 75 kg; 2.5 mg/kg; 15 °C 

o Exception: 75%; $98; =3; ≤5 

Use any symbols to clarify mathematical relationships 

● For example: ratios (5:1); magnification (100×); 3-fold (not threefold) 

Ordinal numbers – show rank order and not a quantity. They are numbers in a sequence and are seen more as part 

of a description or part of a sequence. 

● Spell out single digit ordinals (1-9) that are adjectives or adverbs. 

o For example: the first duckling emerged; the ninth time 

● Use numerals for 2-digit ordinals (10 and higher). 

o For example: for a 10th time; the 19th century; the 98th test 

o Note: Make sure a “th” is not superscripted. 

● Single digits may be used if it is clearly a series. 
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o For example: The 5th, 8th, and 10th steps involved… 

o For example: We developed 12 hypotheses… tested the 1st… The 11th was… 

Spell out fractions. Hyphenate 2-word fractions. 

● For example: one-half (or half); two-thirds 

o Note: Fractions greater than 1 use a slash (/) or special character if the value is not precise. 

▪ For example: 3½ years; approximately 2 5/8 yards 

o Note: If the number needs to be precise, use a decimal or percent. 

Dimensions – use multiplication symbols between the separate measurements. Units for each measurement must 

be the same and can appear at the end of the combined measurements or after each number. 

● For example: 10 × 55 × 5 mm OR 10 mm × 55 mm × 5 mm 

 

FORMAT OF NUMBERS 
(CSE Style Manual; 12.1.3; p. 161-163) 

Separate every three digits with a comma. Exception is after a decimal point, which is a period (.) not a comma. 

● For example: 143; 2,461; 21,278; 1,409,000; 3.14; 0.32147; 47,938.275 

Put a zero before decimals. 

● For example: 0.32, not .32. 

Significant digits – the number of digits used should reflect the precision of the measuring device or how 

scientifically important the value is. So if a scale is only accurate to 0.1 g, the number can only have one number 

after the decimal. Having extra numbers is distracting and does not add to the information being shared. 

● Note: Rounding – in general only two significant digits are needed when rounding. Less than 5, round down; 

5 or more, round up. 

o For example: 4.282 becomes 4.28; 4.286 becomes 4.29 

o Note: Only round for reporting, NOT for data analysis. 

 

SCIENTIFIC NOTATION 
(CSE Style Manual; 12.1.5; p. 165-166) 

Very large numbers that need to be precise should be presented with powers of 10. 

● For example: 2.6 × 104 NOT 26,000; 4.23 × 108 NOT 423,000,000; 7.41 × 10-6 NOT 0.000,007,41 

If a standard deviation (measure of spread) is necessary, put that number in parentheses with the “SD” denoted. 

● For example: 7.4 × 103 (SD, 0.4 × 103) OR 7.4 (SD, 0.4) × 103 

o Note: Number of significant digits should be the same between the number and the standard deviation. 

Large numbers that do not need to be precise should not follow this format. 

 

AZVT recognizes weights, drug dosing, and other measurements that are indicated in the metric 

measurement system. If you submit weights, drug dosing, etc. in the English measurement system, you will 

be asked to convert the measurements to the metric system.



 
 

ACCEPTABLE ABBREVIATIONS 
Table: List of Abbreviations. This is only a partial list of abbreviations that are acceptable for use. You may also 

reference the CSE Manual, 8th Edition (2014). This list has been modified from the Journal of Zoo and Wildlife 

Medicine’s Author Guidelines. 

 

Word or Phrase Abbreviation Word or Phrase Abbreviation 

Analysis of variance ANOVA Meter(s) m 

Beats per minute bpm Micrometer(s) µm 

By mouth (per os) / Oral admin. p.o. or PO Milliampere-seconds mAs 

Calorie(s) (small, gram calorie) cal Millequivalent(s) mEq 

Calorie(s) (large, kilogram calorie) kcal Milligram(s) mg 

Cardiopulmonary resuscitation CPR Milliliter(s) mL 

Centi- c or × 10-2 Millimeter(s) mm 

Cerebrospinal fluid CSF Millimolar (concentration) mM 

Complete blood count CBC Millimole(s) (mass) mmol 

Computed tomography scan CT scan Minute(s) min 

Crossed with, multiplied by × Month(s) Mo or mos 

Cubic centimeter cm3 Molar (concentration) M 

Deci- 10-1 Nano- n or × 10-9 

Degree(s) Centigrade °C Nonsteroidal anti-inflammatory drug NSAID 

Degree(s) of freedom df Normal (concentration) N 
Enzyme-linked immunosorbent assay ELISA Oil-immersion field oif 

Electrocardiogram ECG Once a day SID 

Et alia et al. Outside diameter o.d. 

Et cetera etc. Oxygen saturation SPO2 

Ethylenediaminetetraacetic acid EDTA Packed cell volume PCV 

For example e.g. Part(s) per million ppm 

End tidal carbon dioxide  ETC02 Percent (with number only) % 

Four times a day QID Polymerase chain reaction PCR 

Gauge ga Probability P 

Gram(s) g Red blood cell RBC 

Hectare(s) ha Revolution(s) per minute rpm 

Hertz Hz Sample size n 

High-power field hpf Second(s) sec 

Hour(s) hr Species (only after a genus name) sp. or spp. 

Inside diameter i.d. Specific gravity sp. gr. 

International units IU Square centimeters cm2 

Intramuscular IM Standard deviation SD 

Intraperitoneal IP Standard error SE 

Intravenous IV Standard error of the mean SEM 

Kilo- k or × 103 Subcutaneous SC or SQ 

Kilohertz kHz That is i.e. 

Kilovolt peak, tube voltage kVp Three times a day TID 

Lethal dose 50% LD50 Twice a day BID 

Liter(s) L Versus vs. 

Magnetic resonance imaging MRI Volume vol 

Mean x Week(s) wk 

Mega- M or × 106 Weight(s) wt 

Megacalorie(s) Mcal White blood cell WBC 

Megahertz MHz Year(s) yr 

19 
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 REFERENCE GUIDE 
 

Beginning in 2016, the Program Co-Chairs elected to adjust the Reference format for authors to follow the Council 

of Science Editors Manual, 8th Edition (2014). For more information, please visit: 

http://www.scientificstyleandformat.org/Tools/SSF-Citation-Quick-Guide.html 

Or see [CSE] Council of Science Editors. 2014. Scientific style and format: The CSE manual for authors, editors, 

and publishers. 8th ed. Chicago (IL): The University of Chicago Press. 

Below are several examples of the reference formatting as required by AZVT. References are not required for 

abstracts. If you wish to include references in your abstract, contact the Editor-in-Chief. 

REFERENCE SYSTEM 

AZVT follows the Name-Year Reference System (not the Citation-Sequence Reference System) of the CSE 

Manual (2014, p.551-554). Do not use numbered footnotes in your abstract/paper since AZVT turns product and 

drug information into footnotes. 

● Following the referenced sentence(s), with or without quotation marks (see below), the citation is included 

in the body of the paper with the first author’s last name and the year of publication (Smith 2002). 

● If two authors contributed to a paper, include both last names and the year (Smith and Jones 2002). 

● If more than two authors contributed to a paper, list the first author’s last name, followed by “et al.” and 

the year (Smith et al. 2002). 

● If you are referencing more than one article, list them in chronological order from oldest to newest and 

separate with semicolons (Smith 2002; Jones 2005). 

● If you are referencing more than one article published in the same year, list them in alphabetical order by 

first author last name and separate with a semicolon (Jones 2002; Smith 2002). 

● A combination of the above may be applied if needed. 

● You may also include the author name at the beginning of a sentence, with the year in parenthesis (e.g. 

“Smith (2002) suggests that…”). 

● The citation is included inside the sentence (i.e. the punctuation mark is written after the citation). 

Reference Software 

There are several options for reference management software. You or your institution may be interested in one of 

these for tracking references. These management systems generally offer citation assistance, where the reference 

may be transformed into the appropriate citation and reference format, based on the style you are using. 

Examples of reference software that can be downloaded (have a cost associated with them): 

Endnote (https://endnote.com/) and Refworks (https://www.refworks.com/refworks2/) 

Example of a free reference manager resource that can be added in to web browsers: 

Zotero (https://www.zotero.org/) 
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Examples of free citation/reference generators online (make sure any of these generators is set to the Name-Year 

style, and NOT Citation-Sequence). NOTE: You should always verify/review the results from these types of 

websites: 

Citation Machine (http://www.citationmachine.net/council-of-science-editors-author-date) 

BibMe (http://www.bibme.org/council-of-science-editors-author-date) 

CiteThisForMe (http://www.citethisforme.com/council-of-science-editors-author-date/source-type) 

DIRECT QUOTES VERSUS PARAPHRASING – PLAGIARISM CONCERNS 

There are special considerations in order to avoid plagiarism. Information that is directly quoted (verbatim from 

the resource) MUST be placed within quotation marks (“ “). These words are not your own and must be 

acknowledged as such. In addition, the page number(s) where the quote is located in the article must be included 

within the citation (Smith, 2002, p. 300). 

If you take any information, ideas, concepts, theories, etc. from another author, but rephrase or rewrite the 

information such that it is not verbatim from the resource, you must still cite the source of that information, idea, 

concept, theory, etc. The idea is not your own and the author must be acknowledged. The exceptions are the 

concepts and ideas that are considered “common knowledge” within a profession or society. 

JOURNAL NAME SHORTHAND 

Use the abbreviated name when indicating a journal (i.e., J Zoo Wildl Med, rather than Journal of Zoo and Wildlife 

Medicine). Information on the proper shorthand for journal titles may be found at the following websites: 

● U.S. National Library of Medicine. Construction of the National Library of Medicine Title Abbreviations 

(https://www.nlm.nih.gov/tsd/cataloging/contructitleabbre.html) 

● NIH LinkOut Journal Lists 

(https://www.ncbi.nlm.nih.gov/projects/linkout/journals/jourlists.fcgi?type=journals&typeid=1&format=h

tml&show=ALL&operation=Show) 

● Web of Science, Journal Title Abbreviations 

(https://images.webofknowledge.com/images/help/WOS/A_abrvjt.html) 

REFERENCE LIST 

Your reference list should appear at the end of your paper in alphabetical order by the first author’s last name. 

 

 

 

REMEMBER: YOU are responsible for the accuracy of your references! 
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CSE STYLE GUIDE 
Guide for Citations and References 

 

Based on [CSE] Council of Science Editors. 2014. Scientific style and format: The CSE manual for authors, 

editors, and publishers. 8th ed. Chicago (IL): The University of Chicago Press. ISBN-13: 978-0-226-11649-5. 

This guide gives a limited number of examples using this scientific style. If you need additional help, please see 

http://www.scientificstyleandformat.org/Tools/SSF-Citation-Quick-Guide.html or you may contact the Editor-

in-Chief, who has a copy of the CSE Manual. This guide shows examples from the name-year system (not the 

citation-sequence system), which is the format used by AZVT. 

In the CSE style system, journal titles are abbreviated following ISO 4 formatting (see Appendix 29.1, CSE 2014). 

For details, see the ISSN database (http://www.issn.org) or visit: 

● Web of Science, Journal Title Abbreviations 

(https://images.webofknowledge.com/images/help/WOS/A_abrvjt.html) 

● U.S. National Library of Medicine. Construction of the National Library of Medicine Title Abbreviations 

(https://www.nlm.nih.gov/tsd/cataloging/contructitleabbre.html) 

● NIH LinkOut Journal Lists (see link above) 

 

 

Type of Entry References 
Examples from CSE Manual, 2014 (p.551-649) 

Citations 

Journal Articles   

Single author 
CSE Manual 29.2.1.2 

Fauci AS. 2002. Smallpox vaccination policy—the need for 

dialogue. N Engl J Med. 346(17):1319-1320. 

(Fauci 2002) 

Same author, 

Different year 
CSE Manual 29.2.1.2.1 

Smith CE. 1970. Studies on arbovirous epidemiology 

associated with established and developing rice culture. 

Introduction. Trans R Soc Trop Med Hyg. 64(4):481-482. 

Smith CE. 1975. The significance of mosquito longevity and 

blood-feeding behaviour in the dynamics of arbovirous 

infections. Med Biol. 53(5):288-294. 

(Smith 1970, 1975) 

Same author, Same 

year 
CSE Manual 29.2.1.2.2 

Andrews JE. 1960a. Cold hardiness of sprouting wheat as 

affected by duration of hardening and hardening 

temperature. Can J Plant Sci. 40(1):93-102. 

Andrews JE. 1960b. Cold hardening and cold hardiness of 

young winter rye seedlings as affected by stage of 

development and temperature. Can J Bot. 38(3):353-363. 

(Andrews 1960a, 

1960b) 
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Same surname, 

Different authors 
CSE Manual 29.2.1.2.3 

Dawson J. 1986. Animal experiments: conference report. 

BMJ. 292(6536):1654-1655. 
 

Dawson M. 1986. Some examples of necessary continuation 

and possible discontinuation of animal experiments. Acta 

Physiol Scand Suppl. 554:194-197. 

(Dawson J 1986; 

Dawson M 1986) 

More than one 

author 
CSE Manual 29.2.1.2.4 

Mazan MR, Hoffman AM. 2001. Effects of aerosolized 

albuterol on physiologic responses to exercise in 

Standardbreds. Am J Vet Res. 62(11):1812-1817. 

(Mazan and Hoffman 

2001) 

 

Two authors with the same surname. 

Same formatting as above. 

(Smith TL and Smith 

UV 1990) 

Three or more authors up to 10. After 10 authors, write 

et al. in the reference. 

If first author has been cited more than once, then 

additional co-authors can be included in the citation. 

Same formatting as above. 

 

Volumes and Supplements must also be noted. 

(Ito et al. 1999) 

or 

(Martinez, Fuentes, et 

al. 1990) 

or 

(Martinez, Fuentes, 

Ortiz, et al. 1990) 

Books   

Whole Book with 

Author(s) 
CSE Manual 29.3.7.2 

Schott J, Priest J. 2002. Leading antenatal classes: a practical 

guide. 2nd ed. Boston (MA): Books for Midwives. 

(Schott and Priest 

2002) 

Whole Book with 

Editor(s) 
CSE Manual 29.3.7.2.1 

Leeper FJ, Vederas JC, editors. c2000. Biosynthesis: 

Polyketides and vitamins. New York (NY): Springer. 

“c” indicates the copyright date. Use if publication date 

cannot be located. 

If three or more years separate the publication and 

copyright dates, indicate both dates, e.g. “2002, c1997” 

If a publication date cannot be found, indicate [date 

unknown]. 

(Leeper and Vederas 

c2000) 

Parts or Contributions to Books 
CSE Manual 29.3.7.2.10 

Section of a Book 

with Author(s) 

Shakelford RT. 1978. Surgery of the alimentary tract. 

Philadelphia (PA): W.B. Saunders. Chapter 2, 

Esophagoscopy; p. 29-40. 

(Shakelford 1978) 
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Section of a Book 

with Editor(s) – No 

Separate Authors  

Magalini SL, Magalini SC, de Francisci G, editors. 1990. 

Dictionary of medical syndromes. 3rd ed. Philadelphia 

(PA): Lippincott. Dean-Barnes; p. 230-231. 

(Magalini et al. 1990) 

Section in Book – 

Different Authors for 

Each Chapter and 

Editors for Whole 

Book 

Anderson RJ, Schrier RW. 2001. Acute renal failure. In: 

Braunwald E, Isselbacher KJ, Petersdorf RG, editors. 

Harrison’s principles of internal medicine. 15th ed. New 

York (NY): McGraw-Hill. p. 1149-1155. 

(Anderson and Schrier 

2001) 

Organizations or 

Companies as the 

Author 
CSE Manual 29.2.1.2.5 

[IOM] Institute of Medicine (US). 1975. Legalized abortion 

and the public health; report of a study by a committee of 

the Institute of Medicine. Washington (DC): National 

Academy of Sciences. 

If possible, organization names should be assigned a 

shorthand so that the citation does not require the entire 

name. 

(IOM 1975) 

Conference Proceedings and Papers 
CSE Manual 29.3.7.3 

Whole Conference 

Proceedings 

 

General reference 

Antonioli GE, editor. c1997. Pacemaker leads 1997. 

Proceedings of the 3rd International Symposium on 

Pacemaker Leads; 1997 Sep 11-13; Ferrara, Italy. Bologna 

(Italy): Monducci Editore. 

(Antonioli c1997) 

Include dates of the 

conference 

Include publisher 

information/location 

Callaos N, Margenstern M, Zhang J, Castillo O, Doberkat EE, 

editors. c2003. SCI 2003. Proceedings of the 7th World 

Multiconference on Systematics, Cybernetics and 

Informatics; 2003 Jul 27-30; Orlando, FL. Orlando (FL): 

International Institute of Informatics and Systematics 

(Callaos et al. c2003) 

Paper in Conference 

Proceedings 

Lee DJ, Bates D, Dromey C, Xu X, Antani S. c2003. An 

imaging system correlating lip shapes with tongue contact 

patterns for speech pathology research. In: Krol M, Mitra S, 

Lee DJ, editors. CBMS 2003. Proceedings of the 16th IEEE 

Symposium on Computer-Based Medical Systems; 2003 

Jun 26-27; New York, NY. Los Alamitos (CA): IEEE 

Computer Society. p. 307-313. 

(Lee et al. c2003) 

Online Resources 
CSE Manual 29.3.7.13 
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Websites and 

Homepages 

APSnet: Plant pathology online. c1994-2005. St. Paul (MN): 

American Phytopathological Association; [updated 2005 

Jan 1; accessed 2005 Jun 20]. http://www.apsnet.org/. 

(APSnet c1994-2005) 

Specific Page on a 

Website 

[CDC] Centers for Disease Control and Prevention. c2020. 

Hantavirus. Atlanta (GA): Centers for Disease Control and 

Prevention [updated 2020 Sept 9; accessed 2021 Jan 14]. 

https://www.cdc.gov/hantavirus/ 

(CDC c2020) 

Online Journal 

Articles 

Savage E, Ramsay M, White J, Beard S, Lawson H, Hunjan 

R, Brown D. 2005. Mumps outbreaks across England and 

Wales in 2004: Observational study. BMJ. [accessed 2005 

May 31];330(7500):1119-1120. http://bmj.bmjjournals.com/ 

cgi/reprint/330/7500/1119. doi:10.1136/bmj.330.7500.1119. 

(Savage et al. 2005) 

e-Books Griffiths AJF, Miller JH, Suzuki DT, Lewontin RC, Gelbart 

WM. c2000. Introduction to genetic analysis. 7th ed. New 

York (NY): W. H. Freeman & Co.; [accessed 2005 May 

31]. http://www.ncbi.nlm.nih.gov/books/bv.fcgi?call=bv. 

View.ShowTOC&rid=iga. TOC. 

(Griffiths et al. c2000) 

Online Handbooks Alderson P, Green S, Higgins J, editors. [modified 2005 Jun 

6]. Cochrane handbook for systematic reviews of 

interventions. Ver. 4.2.4. Oxford (UK): The Cochrane 

Collaboration; [accessed 2005 Jun 20]. http://www. 

cochrane.org/resources/handbook/. 

(Alderson et al. [mod 

2005]) 

PDF Lawrence R A. 1997. A review of the medical benefits and 

contraindications to breastfeeding in the United States. 

Arlington (VA): National Center for Education in Maternal 

and Child Health (US); [accessed 2005 Jun 28]. 

http://www.ncemch.org/pubs/PDFs/breastfeedingTIB.pdf. 

(Lawrence 1997) 

Technical Reports 
CSE Manual 29.3.7.4 

Written and 

Published by 

Sponsoring 

Organization 

Feller BA. 1981. Health characteristics of persons with 

chronic activity limitation, United States, 1979. Hyattsville 

(MD): National Center for Health Statistics (US). Report 

No.: VHS-SER-10/137. Available from: NTIS, Springfield, 

VA; PB88-228622. 

(Feller 1981) 
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Written by 

Performing 

Organization – 

Published by 

Sponsoring 

Organization 

Cooper LN (Department of Physics, Brown University, 

Providence, RI). 1990. Theoretical and experimental 

research into biological mechanisms underlying learning 

and memory. Final progress report 1 Aug 88-31 Jul 89. 

Washington (DC): Air Force Office of Scientific Research 

(US). Report No.: AFOSR-TR-90-0672. Contract No.: 

AFOSR-88-0228;2305;B4. Available from: NTIS, 

Springfield, VA; AD-A223615. 

(Cooper 1990) 

Written and 

Published by 

Performing 

Organization 

Moray NP, Huey BM. 1988. Human factors research and 

nuclear safety. Washington (DC): National Academy Press. 

Contract No.: NRC-04-86-301. Available from: NTIS, 

Springfield, VA; PB89-175517. Sponsored by the Nuclear 

Regulatory Commission. 

 

(Moray and Huey 

1988) 

 

No Author or Unknown Publication Date 
No Author Identified 
CSE Manual 29.2.1.2.6 

Handbook of geriatric drug therapy. c2000. Springhouse 

(PA): Springhouse. 

(Handbook… c2000) 

Unknown 

Publication Date 
CSE Manual 29.2.1.2.8 

Lederer J. [date unknown]. Ailmentation et cancer [Diet and 

cancer]. 3rd ed. Brussels (Belgium): Nauwelaerts. 

(Lederer [date 

unknown]) 

Updated 11/2019               Further details and additional reference specifics in the CSE Manual (2014) 

 

 

Using another type of resource? Maps, images, audiovisuals, legal materials, dissertations, etc. all have specific 

formatting. Please contact the Editor-in-Chief to get information about how to appropriately cite your source. 

 

 

Personal Communication 

Since personal communications cannot be accessed by others using databases or online, they are not cited in 

the reference section. Instead, cite the name of the person you spoke with, followed by the indication that it is 

a personal communication and the most approximate date of the communication that you can give: 

 

i.e. “…Many designers do not understand the needs of disabled people according to J.O. Reiss (personal 

communication, April 18, 2000)…” 

 

OR “…Many designers do not understand the needs of disabled people (J.O. Reiss, personal 

communication, April 18, 2000)…” 
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TRACK CHANGES INSTRUCTIONAL GUIDE 
 
These instructions apply to Word for Office 365, Word 2019, Word 2016, and Word 2013. 

For information on Word 2010 or Word 2007, please visit the provided links for more information. 

 

TRACK CHANGES IN WORD 

Information below may be found at the Microsoft Office support page (https://support.office.com/en-us/article/track-changes-in-

word-197ba630-0f5f-4a8e-9a77-3712475e806a) – Page accessed 11/17/2018 

 

Turning on Track Changes gives you and your coworkers a way to make changes that are easy to spot. The 

changes are like suggestions that you can review, and then remove them or make them permanent. 

Turn Track Changes on and off by going to Review > Track Changes. 
 

 
 

● When it's turned on, deletions are marked with a strikethrough, and additions are marked with an 

underline. Different authors' changes are indicated with different colors. 

● When it's turned off, Word stops marking changes, but the colored underlines and strikethrough are still 

in the document. 

View suggested changes 

To review the changes in your document, go to Review > Tracking > Display for Review. 

● To review the changes, indicated by a red line in the margin, choose Simple Markup. 

● For a detailed view of the changes, choose All Markup. 

● For a preview of how the document will look if you make all the suggested changes permanent, choose 

No Markup. 

● To view the original document as if all the suggested changes were removed, choose Original. 

There is a video at this link that explains Track Changes as well.  

 

 

ACCEPT TRACKED CHANGES 

Information below may be found at the Microsoft Office support page (https://support.office.com/en-us/article/accept-tracked-

changes-4838d24c-d5d1-4c6c-8e39-78b44bd2b4cc?ui=en-US&rs=en-US&ad=US) – Page accessed 11/17/2018 
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Even if Tracked Changes is currently turned off, there's a possibility that your document contains colored 

underlines and strikethrough, indicating insertions and deletions that were made as suggestions while Track 

Changes was turned on. 

The markings are visible to anyone who chooses All Markup or Simple Markup in the Tracking section of the 

Review tab. 

 

Remove the markings by accepting or rejecting the changes. Use the buttons in the Changes section of the 

Review tab. 

 

● Previous and Next take you from one change to the next. 

● Accept makes a change permanent. 

● Reject gets rid of a change. 

Tips: 

● To accept or reject changes all at once, click the arrow on the Accept or Reject button, and then choose 

Accept All Changes or Reject All Changes. 

 

There is a video at this link that explains Track Changes as well.  
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INSERT OR DELETE A COMMENT 

Information below may be found at the Microsoft Office support page (https://support.office.com/en-us/article/insert-or-delete-a-

comment-8d3f868a-867e-4df2-8c68-bf96671641e2?ocmsassetID=8d3f868a-867e-4df2-8c68-bf96671641e2&ui=en-US&rs=en-

US&ad=US#ID0EABAAA=Insert_or_delete_a_comment) – Page accessed 11/17/2018 

 

Attaching your comments to specific parts of a document makes your feedback more clear. If someone else is 

commenting on the document, replying to their comments lets you have a discussion, even when you're not all in 

the document at the same time. 

1. Select the content you want to comment on. 

2. Go to Review > New Comment, and make your comment. If you want to make changes to any of your 

comments, just go back and edit them. 

3. To reply to a comment, go to the comment, and select Reply. 

Delete comments 

Right-click the comment, and choose Delete Comment. 

To delete all the comments in the document, go to the Review tab, click the down-arrow on Delete, and choose 

Delete All Comments in Document. 

 

Comment in a doc 

1. Select the text or graphics you want to comment on. 

2. Select Review > New Comment. 
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3. Type your comment, and select Post. 

 

Bubbles in the margin indicate where someone has left a comment. 

Review comments 

1. On the Review tab, select Show Comments to display all comments in a document. 

2. Select Previous or Next to jump to each comment. 

 

Follow up on comments 

 

● To respond to a comment, click the comment, and select Reply . 

● To dim the appearance of a comment, click the comment, and select Mark as Done . 

● To delete a comment, click the comment and select Delete . 
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GOOGLEDOCS INSTRUCTIONAL GUIDE 
 

If the author and Section Chair are interested in using GoogleDocs, the Editor-in-Chief can send a link to each 

person and allow them to have access to the author’s submission via GoogleDocs. Using this platform, edits can 

be tracked and approved, or not, by either party involved in the process. 

 

Many of the instructions listed in the Track Changes Instructional Guide above will work for GoogleDocs. For 

specific information about GoogleDocs, please visit the Google information site: G Suite Learning Center 

(https://gsuite.google.com/learning-center/products/docs/get-started/#!/) to get started with GoogleDocs. 

 

EDIT AND FORMAT 

Information below may be found at the G Suite Learning Center page (https://gsuite.google.com/learning-center/products/docs/get-

started/#!/section-2) – Page accessed 11/17/2018 
 

2.1 Add and edit text  

Rename your document: At the top of the page, click Untitled document, enter a new title, and click OK.  

Add or edit text: Just click in the page and start typing.  

 
 

2.2 Customize your document  

Depending on what you want to change, choose an option:  

● To customize margins, page color, and orientation, click File > Page setup.  

● To customize text, images, tables, and more, use the toolbar options.  

Note: Some options only appear for certain types of content, such as tables or images.  

 
Undo or redo your last changes or print your document.  

 
Copy formatting from any text and apply it to another selection of text.  

 

Change the style, font, or font size.  

 
Make text bold, in italics, or underlined or change the text color.  
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Add or change the text highlight color.  

 
Insert a link, comment, or image.  

 
Change the text alignment.  

 
Change the line spacing or add numbers or bullets.  

 
Change the text indentation.  

 
Remove text formatting.  

Table and image options  

 

Add background color to a table or change the border color, width, or 

style.  

 
Crop an image.  

Image options…  Change the color, transparency, brightness, or contrast.  

 
Replace an existing image with a new one.  

 

2.3 Add pictures, links, tables, and more  

The Insert menu lets you add different features to your document. Here are the highlights:  

Image—Insert an image from your computer, the web, Drive, and more.  

Table—Select the number of columns and rows to create a table.  

Drawing—Create shapes, pictures, and diagrams right in your document.  

Link—Add a link to another page or to a header or bookmark in the same document.  

Bookmark—Add shortcuts to specific places within your document.  

Table of contents—Create an auto-generated table of contents that links to each heading in your document that 

has a heading style applied.  
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2.4 Create page columns  

If you’re working on an academic paper or another large document, you can organize your text in columns.  

1. Click Format > Columns.  

2. Select the number of columns you want.  

3. (Optional) To adjust the spacing, or add lines between column, click Format > Columns > More 

options.  

4. Click Apply.  
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GUIDE FOR PRESENTATIONS 
 

The following recommendations are intended to help AZVT speakers prepare effective presentations. Please 

review these tips; if you have questions or would like advice, please contact one of the AZVT Program 

Chairpersons. 

ORGANIZATION OF THE PRESENTATION 

The minimum time slot for presentations is 30 minutes. This does not include time for questions afterward. The 

5 minutes for questions will be built into the conference schedule. You can request a longer presentation time 

slot; notify one of the Program Chairpersons as early as possible so that they can arrange the schedule 

appropriately. 

Create an Outline 

Prepare an outline of your presentation – this may help you decide how much time you will require. 

At a minimum, you should include an introduction about your topic to orient your audience. Details related to 

what you did and why, and the results or conclusions of what you did should also be presented. 

The “Take Away” Message 

Determine the "take-away" message(s) you most want your audience to receive from your presentation; focus 

your outline with this in mind. Your presentation should capture the highlights of your topic; leave the in-depth 

details for your paper. 

PREPARATION OF VISUAL MATERIALS 

Presentation Software 

If you have access to presentation software, such as Microsoft® PowerPoint (Redmond, WA, 98052), it is an 

ideal way to prepare the slides for your presentation. Other possible presentation programs include Prezi 

(https://prezi.com/) and GoogleSlides (https://www.google.com/slides/about/), both of which require an internet 

connection. There are also other online resources for presenting that may be used, but all of these depend on a 

reliable internet connection at the conference location. 

Template Design and Colors 

For any presentation, avoid using a template design that is very busy or with uncomplimentary contrast (e.g. 

slides with a blue background and red writing). Be sure not to overcrowd the slide with tiny print – more slides 

with less information is better. 

Resist the temptation to use the entire color palette in your presentation software! Some of the very bright colors 

are distracting, or the text could get lost when placed against the background. Also, consider that some in your 

audience could be red/green color blind. 

Font Size 

Use a large enough font size so that your audience will clearly see the text, even from a distance. If you are 

having trouble fitting your text on one slide, reorganize your material onto two or more slides. 
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Images and Videos 

Be sure all photographs are clear and properly lighted. Avoid extraneous images; focus on your main topic. 

Photographs must be in good taste; i.e. be sensitive to your audience when showing a necropsy image. 

Video clips can be very effective for your presentation and in some cases can be inserted directly in the 

presentation. You can also record specific short segments to illustrate a point or, if necessary, you can record 

your whole presentation. 

● Be sure to contact one of the Program Chairpersons if you require any special technical gear so that one 

might be provided at the conference. 

● Be sure to connect with the Audio/Visual person well in advance of the conference if you have an 

embedded video clip in your presentation to make sure your media works! 

Presenting from a Distance 

AZVT has the ability to allow you to present from a distance by using online communication programs such as 

Skype (https://www.skype.com/en/) or Zoom (https://zoom.us/). These presentation platforms allow you to 

present your slides and speak over them. 

● NOTE: If you are going to use one of these platforms, you MUST have a headset/headphones with a 

microphone to avoid sound feedback during your presentation. Many headphones from mobile phones 

have microphones built into them, and can serve as a convenient headset for presenting online. 

MOST IMPORTANT - Have fun! This is a great opportunity to show off your creative skills. Humor (in good 

taste!) is always welcome and appreciated. 
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GUIDE FOR POSTER LAYOUT 
 

The following recommendations are guidelines for AZVT poster presentations. Please review these tips. You can 

request editing assistance for your poster from your Section Chair or the Editor-in-Chief. If you have questions 

or would like advice, please contact one of the AZVT Program Chairpersons. 

● Generally, the standard size for posters is 3 × 4 ft. 

● Use a font size sufficient for the material to be clearly readable from a distance of 4 to 6 feet from the poster. 

● The title will stand out if it is CAPITALIZED with letters approximately 2 in tall. 

● Bold headings will direct the reader's eye from section to section. Some suggested headings are: 

o Purpose/Objective/Hypothesis 

o Method 

o Results 

o Conclusions 

● The content of the poster should reflect the information in your abstract. 

● The viewer should be able to read the material in a few minutes, so details should be minimized as much as 

possible. As author, you will be able to provide detailed information verbally or by providing a written hand-

out during the poster session. 

o Hand-outs should not be too lengthy (1-2 pages) and they should enhance the information on your poster. 

Hand-outs can also be left by your poster, so if you are not there, viewers can take the hand-out with 

them. Be sure to include your contact information on the hand-out, so they can contact you with 

questions. 

● The average size for poster boards is 4 × 6 ft. The poster will be affixed to provided boards or walls via push 

pins or Velcro®, or they may sit on provided easels. The details of what will be provided at the poster session 

will vary from year to year and from location to location. 

● Please Note: AZVT does not provide printing services for posters. You must find a way to transport your 

poster to the conference, either via a sturdy poster tube, by mail, or by printing at a retail center near the 

conference location. 

The poster session information will be sent to you prior to the conference. Your poster will either be presented 

during a break or there will be a separate poster session. This is dependent on a number of factors, including the 

number of posters submitted for the year and also the conference organizer. You will be notified as to which day 

you will be presenting your poster as soon as that information is available. 

You may or may not have time to set up your poster prior to the morning presentations, depending on the situation 

at the conference site. It may be suggested that you set up your poster during the presentation immediately 

preceding the poster break. Please be available throughout the poster session to answer questions. 

If you have any questions, please contact one of your Program Co-Chairs. 


